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Client Registration

Intake is the process of collecting information concerning the client and his or her support system, as
well as determining program eligibility prior to any services being provided and funded. The following
procedures should be followed at the time a new client is to be entered in the Provide® Enterprise
system.

Registration Verification

Prior to entering the client in the Provide® Enterprise database, you should check to make sure that the
client has not previously been entered in the database. To verify that the client has not already been
registered, follow the steps below.

Find Client

The Find Client function will search the entire database to see if the client has previously been entered
in the system and, therefore, has received Ryan White Part B services in the past. To do this, follow the
steps below:

e Select the Find — Client screen in the menu bar.

e This will activate the Search criteria screen, seen in the figure below:

H 4 Close \7‘ (&) Search

| Find Client

Find Client

First Name:

Middle Initial

Last Name

»

Birth Date -

4

Sex Assigned at Bith o

SSN

URN

Provide Client [D

Surveillance StateNo

PEM Member ID

Medicaid 1D

Member ID/Policy Number

CliertProfile|D

Find Client Results




e Fill out the search criteria as appropriate and click on the Search button to complete the search.

NOTE: You may not want to enter full SSN or names in the appropriate fields, due to possibility of
prior data entry errors.

® You can enter an asterisk (*) as a wild card to do more general searches.

e After the search is completed, the client records that match the search criteria are listed and
displayed below the search dialog in a view like the one below:
ER=E NG

Name Name Name Gender Birth Home Street Address City State Zip

Femalei/26/2013 414-555-555!

e Simply double click on the record that you wish to view in order to open the desired Client Profile.

e If, after reviewing the Client Profile, you determine that it is not the client that is present at your
agency to receive services, you can move onto the next steps and actually register the client in the
system.

e If you come to the conclusion that the existing Client Profile is that of the client that is listed, follow
the steps listed in the under “Opening an existing client to your Agency”.

Client Registration

If, after searching the database, you determine that the client is NOT in the database, you will want to
register the client in the system. To do that, follow the steps below:

e From the Menu Bar, select Actions — Register Client.

_ Provide Enterprise

File Find View Actions Tools Reports Windows Help

Register Client

® The Register Client screen will appear. The Register screen appears as shown below.

Fill in the appropriate fields. Some of the notable fields in the Register Client form have been detailed
below.

e Legal First Name: Enter the client’s legal First name. LE. if the client’s legal name is William but goes

by Bill, please enter William and not Bill.

e Legal Last Name: Enter the client’s legal Last name.

e Birth Date: Enter the client’s birth date.

e Current Gender Identity: Select what the client’s current gender identity is.

® Sex Assigned at Birth: Select what sex the client was assigned at birth.

e URN: This field will automatically populate based on the client’s name, date of birth, and gender.

e Current HIV Disease Stage: Select the current HIV Disease Stage of the client.

e Housing Type: Select the client’s housing situation.

e Street Address 1: Enter the client’s current street address.

e State: Select what state the client’s current street address is located.

e County: Select what county the client’s current street address is located.

e City: Select what city the client’s current street address is located.




e Agency Assigned Client ID: The “Agency Assigned Client ID” should reflect the ID number that is
used at your agency to identify clients. In addition, if your agency uses a formula to assign ID
number to your clients, GTl can build the formula into this button (as long as the fields used to
compute your ID number are in the Register Client screen). Contact the Provide® Enterprise Help
Desk for more information.

(&) Register Client (&) Link to Client Consent Form

H 4 Close "%

[ Register Client

Register Client  Consert

Legal First Name =

Legal Middle Inttial

Legal Last Mame =

Birth Date = ml;l
Current Gender Identity * v
Sex Assigned at Birth = o

Social Securty Mumber oo

URN 99550101019

Current HIV Dizease Stage =

Primary Language o
Prefemed Witten Communications Language v
Housing Type = o

Street Address 1 e *

Apt / Lot / Floor ]

State = WA o

County = w |

City = I

Zip Code

Primary Phone -

Primary Phone Type ~

Primary Phone Message o

Secondary Phone |{ ) -

Secondary Phone Type v

Secondary Phone Message o

Frovide Client 1D 10087

Agency Assigned Client 1D

On the “Consent” tab of the Register Client form, attach or scan in the client’s Virginia HIV/AIDS Service
Network Consent.

I|| 4 Close "% || {© RegisterClient (2 Link to Client Consent Form

| Register Client

Register Client Consent

Attachment Type * fimage o
Images

& Attach Cave As

|




Once the form is completed, click the Register Client button on the button bar.

At this time, the system will start the duplicate check process to see if this client may already be in the
database. The duplicate check logic looks to ensure there are no existing client records that are possible
duplicates of the client you are trying to register.

If the client you are registering matches an existing client file one any of the below client information,
you will not be allowed to register the duplicate client.

e Exact match on SSN

e Exact match on URN

e Exact match on First and Last Name (only shows for users from your agency unless Virginia DOH)

e Exact match on Last Name and Birthdate (only shows for users from your agency unless Virginia DOH)

e Exact Match on Client ID

e Exact match on Date of Birth, the register client’s Last Name to existing client’s First Name, and
the register client’s First Name to existing client’s Last Name (to catch name reversal errors)

If any of the above matches are made to an existing client file, a screen similar to the following will
appear:

Selector n

The Client you are trying to register may already be in the database. Possible matching Client records are listed below. K
you see the Client in the list select it and click 'Open’ else click Continue”to proceed with the new registration.

]

rEa

FEE L YA

RN Full Name ¢ Gender Date Cf Birth 55N
MRTOD715721 | Tooth , Mark EE_ 1972/07/19 111-11-1116
TOTOD7159721 | Tooth , Thomas Male 197207419 111-11-1114
TMTOO0715721 | Tooth |, Timothy T. | Male 19720719 111-11-1113
Open Continue Cancel

If you believe that one of the clients listed in the duplicate check window is the client you are trying to
register, simply place a checkmark HI next to the client and click the Open button to go to that Client
Profile.




If you believe that one of the clients listed in the duplicate check window is not the client you are trying
to register, click the Continue button. This will do a duplicate check within the system for all of Virginia
Department of Health excluding the clients that were just shown in previous screen. The system will
look to see your role and determine if you can register as a new client. If not able to create as new client
the system will send to Virginia Department of Health as an Open Client Request.

Otherwise, click on the Cancel button to cancel your new client registration.
If you click the Continue button it will do a duplicate check against the database for all Organizations
within that Program type.

If your security settings allow you to override potential duplicate clients, and you are a sub-recipient
agency for Virginia Department of Health, the following prompt will appear. If you click Yes, it will
create a new registration for that client. If you click No, then an Open Client Request will be
automatically sent to Virginia Department of Health. If you click Cancel, the system will cancel out of
the submission of the client you are registering.

If your security settings do not allow you to override potential duplicate clients, the system will
automatically send an Open Client Request to the Virginia Department of Health.

This client appears to already be in the database. If you are confident
that this is a new Client then click Yes below and you will proceed with
the new registration, If not, click Mo and an Gpen Client Request will
be routed to Virginia Department of Health with a request that they
registered this person as a new Client and release the record to you.

Yes Mo Cancel




Completing the Client Profile

This section of the guide will review all of the tabs found within the Client
Profile.

Profile Tab

The Profile tab of the client file shown in the below image is where you will
find key client information, such as name, date of birth, and SSN:

q Cose " |e= = [~ #Et ©Ceate v @ View v © Acton » @ Print ~

Client Profile : Mary Tooth ()
Virginia Department of Health - Care Services - Jason Griffin/co [04/27/72021]

Profle  Deme Address Profiles Care Team Finances Health Benefits  ADAP  Medical  Eligibility

Status |Dpen
Date of Last Service e ||

Legal Last Name * | Taocth

Legal First Mame * | Mary
Legal Middle Initial
Mame Suffix

Prefemed Name
Pop-up Alet Message

SN 111-11-1199

URN MRTO0719722

Provide Client 1D 10064
EMessaging Setup

Olcay to send email? Mo

Olkcay to send text messages? Mo

Fill in the appropriate fields. Some notable fields in the Client Profile form have been detailed below.

® Legal First Name: Enter the client’s legal First name. L.E. if the client’s legal name is William but goes
by Bill, please enter William and not Bill.

® Legal Last Name: Enter the client’s legal Last name.

® Provide Client ID: This will auto-populate with the agency client’s ID.

® URN: This will auto-populate with the client’s unique ID.

@ Status: This will auto-populate indicating if the client is active or inactive.




® EMessaging Setup: To update the client’s e-messaging information, click on the Update button.

EMessaging Setup

Click to update EMessaging ==> Update

Okay to send email? Mo

Olcay to send text messages? Mo

The following screen will appear:

4 Close || « Submit

EMessage Account - Mary Tooth ()
Test Agency - Care Services : Jason Grffin/GTI/ADMIN [05/06/2021]

EMessage Account
Status Pending
Leqal First Name =
Legal Middle Initial
Legal Last Mame *
Curment Gender o "
Date of Birth = =l -
Social Securty Mumber -
Receive Email Messages? e o* "
Receive text messages on cell phone? o >

If the client’s email or phone number was previously entered, the previous values will be displayed.

Fill in the appropriate fields. Some notable fields in the EMessage Account form have been detailed
below.
® Receive Email Messages?: Enter whether the client wants to receive email messages.
® Email Address: Enter the client’s email address and any additional email address that the client
would also like copies of the emails sent.
® Receive text messages on cell phone?: Enter whether the client wants to receive text messages.
® Select your Cell Phone Carrier: Select the client’s cell phone carrier.
® Enter your Cell Phone with Area Code: Enter the client’s cell phone number.

After you have entered this information, click on the Submit to submit the e-messaging update. You
cannot save e-messaging updates “In Progress.” You must Submit your changes or close without saving.

10



Demo Tab

The Demographic section of the client file is where all vital demographic information on a client is
located. Move through each field, filling all available information. The notable fields in the Demo Tab

are detailed below.

® Race — Check all that apply — If you select “Asian” or “Native Hawaiian/Other Pacific Islander” extra
fields will appear asking you to specify the client’s race (shown in the image below).

e Ethnicity — If you select “Hispanic”, an extra “Ethnicity - Hispanic” will appear asking you to specify

the client’s ethnicity.

|| 4 Close ;‘r” [ Save (@ Create v @ View = @ Action ~ (@ Pint =

Client Profile - Mary Tooth ()
Virginia Department of Health - Care Services - Jason Griffin/co [04/27/2021]

Profle Demo  Address

Birth Date

Current Age

Cument Gender [dentity
Sex Assigned at Birth
Gender Pronoun

Race - Check all that apply

Asian

Mative Hawaiian Pacific
lslander

Ethnicity
Ethnicity - Hispanic

Citizenship

Primary Language
Secondary Language
Prefermed Spoken Language
Prefemed Whitten

Veteran (Yes/MNao)?

Profiles

Care Team Finances Health Benefits ADAF  Medical

* | 071941572

48

Eligibility

Female

Female

[] American Indian/Alaska Native

Asian

[] Black or African American

Mative Hawaiian/Cther Pacific lslander
] white

[] Asian Indian
[] Chinese

[] Flipine

[] Japanese
[] kerean

[] vietnamese
[] Cther

[] Wative Hawaiian

[[] Guamanian or Chamormo
[] Samoan

[] Cther Pacfic lslander

Hispanic

[] Mexican

[] Puerto Rican
[] Cuban

[] Cther

11



Address Tab

The Address Tab in the Client Profile holds the client’s current residential address, mailing address, and
phone information.

4 Close

|_ESave @) Create ~ @ View » (D Action = (O Pint -

Client Profile - Mary Tooth ()
Virginia Department of Health - Care Services : Jason Grffin/co [04/27/2021]

Profle Demo Address Profiles Care Team Finances Health Benefts  ADAP  Medical  Eligibility

Home Address

Click to update Address == Update

Housing Type Stable/Pemanent

Address 1 120 Jessie’s Lane
Apt / Lot / Floor

State VA
P Pittsylvania

City Sandy River
£ip Code R

Mailing Address
COK To Send Mail? -

Address 1
Address 2
City

State

Jip R
Comments

Telephone Mumbers
Primary Phone |.[ e |
Primary Phone Type v

Primary Phone Message e

Secondary Phone |{_]. - |

Secondary Phone Type o

Secondary Phone Message »

To update the address, you must click on the Update button. When you click on this button, you will
see the following Address screen:

12



Profle Demo Address Profles Care Team Finances Health Benefits ADAP  Medical  Eligibility

Home Address

Click to update Address === ——

Fill in the fields with the client’s current residential address information.

q Cloze & || (@) Create Scan  «# Submit

Address : Mary Tooth ()
Virginia Department of Health - Care Services - Jason Griffin/GTIFADMIN

Residence  Mail Documentation
Status = ||r| Progress |
Date Effective * | 05/07/2021 =L
Update Type |Interim |
Housing Type & * | Stable/Permanent b

Street Address 1 e *||
Apt /Lot / Floor &

State = v o
County *

City =

Zp * .

On the Mail tab, the client can choose whether the client wants mail to be sent to an address. If you
choose yes, fill in the address details. If there is address information in previous screen and this is the
same address the client wants as the mailing address, click on the user button on the right on “Address
1”.

If the client does not want mail sent to an address select No.

13



4 Close & |@Create Scan  + Submit

Address - Mary Tooth ()
Virginia Department of Health - Care Services : Jason Grffin/GTI/ADMIN

Residence Mal  Documentation
Mail Address
OK To Send Mail? * R D
Addresses (Care o |
Address 1 = | :
Address 2 |
State * o
Mail City . I
Jip o N |
Comments
Comments

On the Documentation tab, you can review already existing proof of residency documentation or you
can add new proof of residency documentation.

q Cloze % || () Create Scan  « Submit

Address : Mary Tooth ()
Vimginia Department of Health - Care Services - Jason Grffin/GTIFADMIN

Residence Mail ~ Documentation
ls existing documentation Fa =
sufficient ? :
. Why nat 7

Proof of Residency Document(s)
BSEBEEaEF[d

Date * Type £ Delete Fag +

14



Select whether the existing documentation is sufficient. If no, you will need to answer “Why Not?”. If
existing documentation is sufficient, you should add new proof of residency documentation. To add
new proof of residency documentation, see the “Create Proof of Residency Scan” section below.

When the address update is complete, hit the Submit button to submit your changes.

Create Proof of Residency Scan

In the Address update record, click on the Create Scan button.

(@) Create Scan  «# Submit

|| 4 Close 1.,7'|

Address - Mary Tooth ()
Virginia Department of Health - Care Services : Jason Grffin/GTI/ADMIN

Residence Mail Documentation

In the Scan record, enter the Document Date, select “Proof of Residency” as the Document Type, select
the “Proof of Residency”, and then scan in or attach the client’s proof of residency documentation.

" Save And Create Ancther @ View -

4 Close J|

Scan : Mary Tooth ()
Vimginia Department of Health - Care Services - Jason Grffin/GTI/ADMIN [05/0772021]

Scanned Document

Document Date * | 05/07/2021 Sk
Document Type * v
Comments

Attachment Type * | File >
File Attachments *

& Attach Savehs [ Launch

15



When finished, click on the Close button and then select Yes to save your changes. You will then be
brought back to the Address Update screen. Or, click on Save and Create Another to save this scan and
open another blank Scan record.

Profiles Tab

This section of the client profile is view and/or create Client Service Profiles and Client Service Category
Profiles.

Client Service Profiles
Client Service Profile records show whether a client is currently opened or closed to your agency.

To create a Client Service Profile, click the New Client Service Profile Record button above the view.

Profile Demo Address Profiles  Care Team  Finances  Health Benefits  ADAP

Client Service Profiles

2 S By B A & 4 A g [ New Client Service Profile Record
|Status ¥ Effective Deleted Agency Client |D Agency ¢

Fill out appropriate fields as needed.

|| q Close %% || [ Link to Client Profile

Client Service Profile - Mary Tooth ()
Virginia Department of Health - Care Services : Jason Grffin/GTI/ADMIN [05/07/2021]

IMain

Agency Assigned Client ID [ |

Status Open |
Status Effective 05/07/2021
Status Reason |New Client |

First Service Date (auto set nightly)

Last Service Date {auto set nightly)

First Ambulatory Service Date {auto set nightly)

Last Ambulatory Service Date (auto set nightly)

Client Service Profile History Records

=Rl R

Date Deleted Field New Value Change Reason Change By

Client Service Category Profile Records

ﬂ =] _‘-51 E% 5. L] _J'—" _1 ﬂ:J j Mew Client Service Category Profile Record
Status © Effective # Deleted Agency ¢ Service Category # Assigned Provider Last Service Date

16



Here, you can see the current status of the Client Service Profile and a history of every time this Client
Service Profile record has been opened or closed.

Depending on the status of the Client Service Profile, you will see either a Close button or an Open
button at the top of the record. You can use these buttons to open or close the client to your agency.

Client Service Category Profiles
Client Service Category Profile records show by which service category(s) a client is being served.

To create a new Client Service Category Profile record, click on the New Client Service Category Profile
Record button.

Client Service Category Profiles

Z S By E% S &2 & |d :H _] Mew Client Service Category Profile Record
Status & Effective £ Deleted Agency ¢ Service Category ¢ Assigned Provider

Select which service category the client is receiving services from, the funding source for this service
category, and the date they started receiving services from this service category. Depending on which
Service Category you pick, an “Assigned Provider” field will appear for you to select the client’s assigned
provider for this specific service category.

4 Close " || [ Link to Client Profile ;5 Link to Client Service Profile

Client Service Category Profile - Mary Tooth ()
Virginia Department of Health - Care Services - Jason Grffin/GTI/ADMIN [05/0772021]

Main
Status Open |
Service Category = |D
Funding Source e
Status Effective 05/07/2021 a
Status Reason Mew Client |

First Service Date (auto set nighthy)
Last Service Date (auto set nighthy)
Client Service Category Profile History Records

EN= REC=l Rl W
| Date Deleted Status Change Reason Change By

When finished, click on the Close button and then select Yes to save your changes.

17



Care Team Tab

This section of the client profile is where the HIV Care Provider, HIV Case Management Provider,
Pharmacy, Authorized Representatives and Provider Relationships are located.

Alternate Contacts are those relationships that were converted from the prior ADAP database for
visibility purposes. Going forward, Authorized Representatives and Providers should be entered in the
appropriate fields.

Client Profile : Marie Castle ()
Virginia Department of Health - Care Services : Peggy Griffith/GTI/ADMIN [06/30/2021]

Profle Demo Address Profiles Care Team Finances Health Benefits ADAP  Enrolments Medical Bligibilty

HIV Care Provider

Primary HIV Care Clinic/Facilty/Practice Maone

Physician providing HIV Medical Care Maone

HIV Case Management Provider

HIV Case Management Agency None

HIV Case Manager None

Pharmacy

Prefemred Retail Phamacy @ |

Authorized Representatives

Number of authorized representatives |D

Altemate Contacts

2 S By a4 [d e [ Add Atemate Contact

Status 7 Share Information Contact Name Cliert Relationship Primary Phone Mumber Deleted
Active Sandy Castle Partner (414) 555-4887

Provider Relationships

H S By LE;] 5 v’r:’ D ErlEl DMd Provider Relationship Record

Status Relationship # Provider # Deleted

18



Finances Tab

The Finances tab of the Client Profile is where the client’s financial information is located. The Finances
tab has four subtabs: Household, Income, Adjustments, Totals. On Household and Income Subtabs, you
may view or update the financial data.

To update the client’s financial data, you must click on the Update button. This Update button will be
found on two of the Finances Subtabs (Household and Income).

” 4 Close q” [ Save (@ Create v (@ View v (@ Action v @ Prnt -

Client Profile : Mary Tooth ()
Virginia Department of Health - Care Services : Jason Griffin/co [04/27/2021]

Profle Demo Address Profiles Care Team Finances  Health Benefits ADAP  Medical Higibility
Household  Income  Adjustments  Totals

Click to update Household and/or Income Data
— Update

Total Household Size

Client Household Members

ER= =R W

Status Last Mame / First Name Relationship Emergency Deleted

Summary Tab
This tab in the Income History record holds the income history’s status, date effective, and update type.

(@) Create Scan  « Submit

4 Close J|

Income History : Mary Tooth ()
Virginia Department of Health - Care Services - Jason Grffin/GTI/ADMIN [05/0772021]

Summary  Household Income  Adjustments  Totals

Status * |In Progress |
Date Income Efective

pdate Type

Changes Summary

Fill in the fields as appropriate.
e Status: Defaults to “In Progress” until the income record is submitted.
e Date Income Effective: Enter the date the income became effective.

19



e Update Type: Automatically defaults to the update type.
e Changes Summary: Detail about what was changed.

Household Tab
This tab shows the client’s current household size.

Alternate Contacts are those relationships that were converted from the prior ADAP database for
visibility purposes. Going forward, Authorized Representatives and Providers should be entered in the
appropriate fields.

Client Profile - Marie Castle ()
Virginia Department of Health - Care Services : Peggy Griffith/GTI/ADMIN [06/30/2021]
Profle Demo Address Profles Care Team Finances Health Benefits ADAP  Enroliments  Medical  Bligibility
Household  Income  Adjustments  Totals
Click to update Household and/or Income Data ===
Update
Total Household Size 1
Client Household Members
FEEL - AL
Status < Last Name # First Name Relationship Emergency Deleted
Atemate Contacts
A5 BB L, Q-
Status Share Information Contact Name Client Relationship Primary Phone Mumber Deleted

Click on Add Household Member button to add an individual to the client’s household.

¥ Save And Create Another

4 Close |

Household Member : Mary Tooth ()
Virginia Department of Health - Care Services - Jason Grffin/GTI/ADMIN [05/0772021]

Main

Status * |TRtive HE
First Name *

Last Name =

Relationship to Client * »
Date Of Birth * = .
Okay to Contact? * »
Comments

20



Fill in all fields with the available household member information. When you are finished, click on the
Close button and select Yes to save your changes.

After you add or update any household members records, you should recompute the household size. To
recompute the household size, click on the Recompute button on the Household Tab in the Income
History record. The household size will then be recomputed.

Income Tab

The Income tab is where you document the client’s incomes. Input the total monthly income of the
applicant and all legal household members in the respective fields. Any income type listed in all caps is

not calculated for MAGI, but is a required field. Fill in each income field with the appropriate amount.
The notable fields have been detailed below.

q Close % || (@) Create Scan " Submit

Income History - Mary Tooth ()
Virginia Department of Health - Care Services - Jason Griffin/GTI/ADMIN [05/0772021]

Summary Household ‘_.ﬁ.djustmerds Totals

Cument Monthhy Household Income
Mote: Input the total monthly income of applicant and all legal household members in the respective
fields. Any Income type listed in all caps is not calculated for MAGI, but is a required field of entry.
Click to D rit that the H hold Has Zero |

=="i @ Hocume = MOUSENCIS Nas £em income Household Has Zero Income
‘Wage Income Calculator

Wage Income Calculator

Click the Household Has Zero Income button to fill all fields with $0.00. Then go through the fields to
update the client’s household income.

Wage Income Calculator button is a calculator to help with processing the wages.

i Dialog Income Calculator for Mary Tooth — O *

Dialog Income Calculator

Wage Income Calculator QK
MNumber of Jobs Cancel
Mumber of Curert Jobs =0

Cther
Cther Monthly Wage Income

Self Employed
Estimated Monthly Income

Totals
Income Calculation * | £0.00

Comments

o Number of Current Jobs: Select between 0 and 6 jobs.

21



Depending on the amount of jobs in the household will determine the next fields. For information
purposes say you select anywhere from 1 to 6 jobs. The form will populate depending on your
selection. Repeat next step for all the jobs selected.

o Job #1 - Pay Frequency: Select whether the client gets paid monthly, weekly, bi-weekly, 2x
month or year to date. This will determine what happens next.
o Monthly: Will ask for two paystubs.
o Weekly: Will ask for eight paystubs.
o Bi-Weekly: Will ask for 4 paystubs.
o 2x Month: Will ask for 4 paystubs.
o Year To Date: Will ask for Start Date and Thru Date. Enter Year To Date Amount.
e Other Monthly Wage Income:
e Estimated Monthly Income:
e Income Calculation: This field is computed depending on your entries. This field will be carried
over to the “Wages, salaries, tips, etc.” field on the “Income History” Tab.
e Comments: Enter necessary comments.

Click OK button to continue.

Wages, salaries, tips, etc: Include the total monthly income that the applicant and any legal household
members receive from Wages or Salary’s (W-2), tip income, and any disability pension benefits received
prior to meeting minimum age requirement.

Pensions and Annuities: Include all income both employer-based and Veterans Administration based on
pension. Note, do not include disability pension income here when disability pay is received prior to
normal pension retirement age.

4 Close °F || \q_} Create Scan " Submit

Income History - Mary Tooth ()
Virginia Department of Health - Care Services : Jason Grffin/GTI/ADMIN [05/07/2021]

Adjustments  Totals

Current Manthhy Household Income

Maote: Input the total monthly income of applicant and all legal househaold members in the respective
fields. Any Income type listed in all caps is not calculated for MAGI, but is a required field of entry.

Iglltf_k to Document that the Household Has Zero Income Household Has Zero Income

Wage Income Calculator Wage Income Calculator
‘Wages, salaries, tips, etc. (Form W-2) g9 =

Taxable intersst (1095-INT fam)

Tax-exempt Interest (Form 1095-INT box 8)

Ordinary Dividends (1095-01V baox 1a)

Exempt Interest Dividends (Fom 1059-INT box 10)

Taxable refunds of stateJocal income taxes

Alimory or Other Spousal Support Received

Business or Seff Employed incomeloss (Schedule C or

CEd)
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Adjustments Tab

The Adjustments tab is where you document the client’s income adjustments. Input the total monthly
adjustments of the applicant and all legal household members in the respective fields. Any income
adjustment type listed in all caps is not calculated for MAGI, but is a required field. Fill in each
adjustments field with the appropriate amount.

If the client has zero income, click on the Household Has Zero Adjustments button and each adjustment
field will automatically fill in as $0.00.

4 Close “Z H (@ Create Scan  +" Submit
Income History : Mary Tooth ()
Virginia Department of Health - Care Services : Jason Griffin/GTI/ADMIN [05/07/2021]
Summary Household  Income  Adjustments  Totals

Current Monthly Household Income Adjustments
%T&;;Erﬁ:f:im L Household Has Zero Adjustments
Educator expenses 5000
Business expenses (Form 2106 or 2106-EZ) &0.00
Health Saving Account (Form 8883) 20.00
Maving Expenses (Form 3503) £0.00
Deductible part of Sef-Employment Tax (Schedule SE) &0.00
Self-employed SEP, SIMPLE plans £0.00
Sef-employed Health Insurance Deduction &0.00
Penalty on eary withdrawal of =avings 20.00
Alimaony paid £0.00
IRA deduction £0.00
Student loan interest deduction £0.00
Tuition and fees (Form 8917) .00
DOMESTIC PRODUCTION ACTIVITIES (Form 8503) 50,00

Totals Tab
The totals tab will calculate the monthly gross income and the household poverty level percentage.

After the employment, household, income, and adjustments tabs have been updated as necessary, you
should recompute the client’s income totals. To do this, click on the Recompute button found on this
Totals tab. The income totals will then be recomputed.
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(@ Create Scan «” Submit

|| 4 Close J|

Income History : Mary Tooth ()
Virginia Department of Health - Care Services : Jason Grffin/GTI/ADMIN [05/07/2021]

Summary Household Income  Adjustments

Totals
Click to recompute all totals fields below ==3
Recompute

Househald Manthly Gross Income Adjustments *

Household Monthly Gross Income =

Household Poverty Level % *

Househald Manthly MAGI *

Household MAGI Poverty Level % =

Proof of Income Documentation
Proof of Income Document(s)

S BREda& & (d -l
‘ Date © Type / Delete Flag #

=

When the income update is complete, hit the Submit button to submit your changes.

Create Proof of Income Scan

In the Income History record, click on the Create Scan button.

|| 4| Close \,,?'|

() Create Scan  « Submit

Income History : Mary Tooth ()
Vimginia Department of Health - Care Services - Jason Griffin

Summary Housshold Income  Adjustments  Totals

Totals

In the Scan record, enter the Document Date, select “Proof of Income” as the Document Type, select the
“Proof of Income”, and then scan in or attach the client’s proof of income documentation.

|| 4 Close \J|

7| Save And Create Another © View -

Scan : Mary Tooth ()
Virginia Department of Health - Care Services : Jason Griffin/GTI/ADMIN [05/07/2021]

Scanned Document

Document Date * [05/07/2021 ==
Document Type * v
Comments

Attachment Type * | File ~
File Attachments *

& Attach [ Save As 3 Launch

When finished, click on the Close button and then select Yes to save your changes. You will then be
brought back to the Income Update screen. Or, click on Save and Create Another to save this scan and
open another blank Scan record.
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When you have finished entering the client’s current income information on all tabs in the Income
Update, click on the Submit button to submit your changes. After you submit the Income update, you
will be brought back into the client’s Client Profile.

Health Benefits Tab

The Health Benefits tab in the Client Profile is where you can view and update the client’s private health
insurance and public health benefits. The Health Benefits tab consists of two subtabs: Private Health
Insurance and Public Health Benefits.

|| 4 Close JH [ Save (@ Create ~ @ View ~ @ Acion ~ @ Print -

Client Profile - Mary Teoth ()
Virginia Department of Health - Care Services : Jason Griffin/co [04/27/2021]

Profle Demo Address Profiles Care Team Financesi
Public Health Benefits  Private Health Insurance

ADAP  Medical Eligibility

Click to update Health Benefits === Update

Medicans
Status

Medicaid
Date Last Verfication Completed

Medicaid Coverage?
Medicaid 1D

Comments

To update any of the health benefits, you must click on the Update button. You can click on Update on
either of the two Health Benefits subtabs.

When you click on the Update button, you will see a view similar to this:

(@) Create Scan  « Submit () Create Health Plan

4 Close w?'|

Health Benefits : Mary Tooth ()
Virginia Department of Health - Care Services : Jason Grffin/GTI/ADMIN [05/07/2021]

Summary Benefits  Insurance  Services

Status *

In Progress
Update Type Interim
Date Effective ull05/07./2021 e I

Summary Tab

On the Summary tab in the Health Benefits update, fill in the appropriate fields:
e Status — defaults to “In Progress” until the health benefits record is submitted.
e Update Type — automatically defaults to the update type.

25



e Date Effective — select the date the health benefits information became effective.

Benefits Tab
Select the client’s Medicare status. If you select any status other than “No Benefits”, additional fields
will show for you to fill in the client’s insurance information.

(£ Create Scan  «" Submit  (2) Create Health Plan

|| 4] Close \.,ir'|

Health Benefits : Mary Tooth ()
Vimginia Department of Health - Care Services - Jason Griffin/GTI/ADMIN [05/0772021]

Summary Benefits Insurance Services

Medicare
Status = [ f o
Effective Date = 2.
Medicare Coverage = o
Comments

Medicare Proof of Coverage Documentis)
FEEE ENEEE
Date © Type © Program * Delete Fag

Medicare Prescription Drug Plan (PDF)
Status * | No Benefits v

Medicaid
Medicaid Checked Ma

Medicaid Status?
Medicaid 1D Number

Comments

If the client has Medicare coverage, you need to create a proof of coverage document by clicking on the
Create Scan button.

In the Scan record, enter the Document Date. Select “Health Benefits Documentation” as the Document
Type, “Proof of Coverage” as the Health Benefits Document Type (see image below).

Then, select either “Medicaid, Medicare, Medicare Part D or Private Medical” as the Health Benefits
Program.
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7| Save And Create Another © View -

H 4 Close J“

Scan - Mary Teoth ()
Virginia Department of Health - Care Services : Jaszon Griffin/GTI/ADMIN [05/07/2021]

Scanned Document

Document Date = |05/07/2021 L
Document Type * |Health Benefits Documentation v
Health Benafits Document * | Proof of Coverage w
Health Benefits Pragram = |f P
Comments

Mtachment Type * | File ~
File Attachments =

& Attach Save As [ Launch

Next, scan in or attach the client’s proof of coverage documentation.

When finished, click on the Close button and then select Yes to save your changes. You will then be
brought back to the Health Benefits Update screen.

When you are finished, click the Close button and then select Yes to save your changes.

Insurance Tab
If the client has private health insurance (either through ACA, Employer, or other Private Source), enter
the required information for the policy based on coverage documentation provided by the client.

Summary Benefits Insurance  Services

Primary Private Insurance

Status * Active ~
Date Fffective * |o10172021 ==
Policy Source * | Employer ~
Insurance Company Name * |CareFirst BlueChaice ‘ -
Insurance Plan Mame * |PPQ Plus |
Pivate Member ID = (13202101 |
Family Plan? * |No ~
Medical Coverage? * | Yes ~
Mental Health Coverage *No v
Substance Abuse Coverage * o -
Substance Abuse Residential Benefits? * o -
Phamacy Coverage Included? * o -
Commerts Verffied client meds are not covered.

Private Proof of Coverage Document(s)

H S B E A P [d 5] @ AdScan Document
Date ™ Type T Program ~ __ Delete Flag ™

2021/08/13 Proaf of Coverage  Private Medical N

Dental Care Policy

Status * | No Benefits v
Vision Care Policy
Status * |iNo Benefits ~

Next, scan or attach the Proof of Coverage documentation provided by the client.

If the client also has access to private coverage for dental and/or vision care, enter the required
information for those policies based on the coverage documentation provided by the client. Then scan
or attach the proofs of coverage.
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When you have finished entering the client’s current health benefits information on all four tabs in the
Health Benefits Update, click on the Submit button to submit your changes. After you submit the Health
Benefits update, you will be brought back into the client’s Client Profile.

ADAP Tab

The ADAP Tab shows links to all ADAP enrollment records as well as historical Client Notes.
Profile Demo Address Profiles Care Team Finances Health Benefts ADAF  Enrolments Medical  Bligibility

Medication Assistance Enrollment Records
TEEY X XX

Date Effective ™ Date End © Status Benefit Level Medication Pickup Site Deleted? /
10072 - VA ACAIC Accomack

2021/07/0 2021/08/01 Teminated 10000 - VA Uninsured  Accomack N

Premium Assistance Enroliment Records
FEEEE AL

Date Effective ™ Date End Status Policy Type Camier Plan Name Deleted? /
Private Medical ~ Anthem HealthKeepers  Anthem HealthKeepers Bronze X 5500 N

Enrolimert Lirks
FEE - EX Y BT
Status # Date Linked * Date Terminated * Primary Secondary Deleted?

HCV Treatment Applications
E 8 By @1 a & ,/‘3‘ d E:!El |_] Create Application
Start Date © Status

ADAP Cliert Notes
2 S By B @ & 4 [ @ [ Add ADAP Cliert Note

Deleted Date © Mote Type Program Entered By
2021/08/17 Premium Peagy Griffith

o Medication Assistance Enrollment Records — embedded view shows all prior and current
enrollments in direct ADAP. To view any record, double-click on the record to open the detail.

ADAP Medication Assistance Enrollment

Status [Envolled |
Date Enrolled 08/02/2021
Beneft Level [10072-VAACAC J
Benefit Effective Date = |08/02/2021

Medicare Effective Date

Medicare Camier Name ‘ |
Medicare Plan Name ‘ |
Medicaid Date Effective

Private Effective Date 07/01/2021
Insurancs Company Name [Anthem HeathKeepers |
Insurance Plan Name [Anthem HeathKepers Bronze X 5500 |

Enmoliment Records Sent to Ramsel
MO BEBaY»S QA

Date Sent * Status

e Premium Assistance Enrollment Records —embedded view shows all prior and current
enrollments in premium assistance (MPAP, ICAP, HIMAP). To view any record, double-click on
the record to open the detail.
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ADAP Premium Assistance Enrollment  Premium Payments  Documentation

Status

Enoliment Type

Date Enrolled

Policy Type

Falicy Source

County of Residence

Heatth Plan Carmier

Plan Name

Bilng ID

Is Client receiving tax credit?
Wihy is Cliert ot receiving tax credit?

. Tax Credit Notes

Policy Coverage Effective Date
Premium Assistance Coverage Start Date
Client Premium Amourt

Premium Amour

Payment Cycle

Mazimum Out of Pocket Amount

Suppart Notes

Enroliments  Historic Data

[Envolled

[New Enrollee

08/02/2021

* |Private Medical

= [ACA Exchange

Accomack

* [Anthem HeathKespers

* |Anthem HealthKeepers Bronze X 5500

* (0802202103

No

Does not file taxes

07/01/2021
08/01/2021
$250.00
$250.00

| Morthy

$1,000.00

o To update premium or Maximum Out of Pocket Information, click on Change > Premium

Information.

() Change » (@ Create ~ (£ Viey

B Premium Information I—
e

[Dialog Change Premium

Set Premium Information

Policy Type

Policy Source

Is Client receiving tax credit?
Why is Clien ot receiving tax
Tax Cred Notes

Policy Coverage Effective Date
Cliert Premium Amourt

Premium Amourt

Paymert Cycle

Maimum Out of Pocket Amount
Support Notes

* [Private Medical

* |ACA Exchange

No

credit? Does not file taxes

070172021
$250.00
$250.00
Monthly
$1.000.00

oK

Cancel

e Enroliment Links — embedded view allows you to link another client who is covered under the
same family insurance policy.
e HCV Treatment Applications — embedded view shows all prior and current applications for HCV

Creat licati .
J reate Application button to submit a

treatments. To create a new application record, click the
new application.

o ADAP Client Notes — embedded view shows historical note entries. ADAP Client Notes are
available only to ADAP users to view, add, and edit notes. To add a new note, click the

_] Add ADAP Client Note button.

Medical Tab

The Medical tab in the Client Profile holds the client’s current HIV information such as current disease
stage, risk factors, and whether they are on ARV.
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4 Close JH [ Save (@ Create ~ @ View = @ Acion ~ @ Pint -

Client Profile - Mary Tooth ()
Virginia Department of Health - Care Services - Jason Griffin/co [04/27/2021]

Profle Demo Address Profies Care Team Finances Health Benefts ADAP  Medical  Eigibility

HIV Status
Cumrent Disease Stage * |AID5

Estimated Date HIV Diagnosed
Estimated Date AIDS Diagnosed

Medeis) of Transmission [ J; Blood Transfusion

[ ] Hemaphilia

[ ] Heterosexual Contact

[] Intravenous Drug Use

] Men Who Have Sex with Men
[] Mother-at-Risk (Perinatal)

[] Other

[] Undetemmined

Cumenthy taking Antiretroviral Therapy? -

Mightly Updated Data
Date Of Last CD4 Count

Last CD4 Court Result

Date Of Last HIV-1 Viral Load

Last HIV-1 Viral Load Result

Date Of Last Medical Appointment Kept

EILIRE I 3

Fill in the fields as appropriate. Depending on the client’s “Current HIV Disease Stage”, fill in their
“Estimated Date HIV Diagnosed”, “Estimated Date AIDS Diagnosed”, “Mode(s) of Transmission” and if
the client is “Currently taking Antiretroviral Therapy”.

The fields on the bottom of the form are reference only. These will be populated as data is entered into
the system. These will be updated nightly and auto-populate when you look at a client’s profile.

Eligibility Tab
The Eligibility tab in the Client Profile has three tabs “Core”, “Supportive” and “History”.

These tabs have the eligibility data for the client after all information has been submitted.
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HQDcse My lem = [ v| #Edt @ Ceate v © View v @ Acton v @ Print ~

Client Profile - Timothy T. Tooth ()
Virginia Department of Health - Care Services - Jason Grffin/GTI [04/1352021]

Profle Demo Address Profles Care Team Finances Health Benefts ADAP  Medical Eligibility

Supportive  History

Date Hligibiity Effective | 05/05/2021
Date Eligibility Expires | 11/30/2021
Last Change Reason Eligibility Assessment
ADAP Medication Assistance Mo

ADAP Premium Assistance Mo

AIDS Phammaceutical Assistance (LPAP/CPAP) Mo

Heatth Insurance Premium and Cost Sharing Mo
Outpatient Ambulatory Health Services Mo

Oral Health Services Mo

Early Intervention Services Yes

Home Health Services Mo

Home and Community-Based Health Services Mo

Hospice Mo

Medical Case Management Mo
Substance Abuse Outpatient Services Yes

Update Client

Anytime you update a client, the client’s information will be updated overnight in Provide®. If you want
or need to update the client’s information immediately, click on the Action — Update Client in the Client
Profile.

4 Close ;?'” gSave @ Create v @ View v (@ Adion ~ & Print -

Client Profile - Mary Tooth () Change Client [dentification ]
Virginia Department of Health - Care Services - Ja Document Death
Profle Demo Address Profiles Care Team Finance Eligibility Termination
Core  Supportive History Set URM Suffix
Diate Eligibility Effective 04 Update Client
Date Higibility Expires |D&;"26;"2'I]2‘I

This Update Client button will pull changes from the following records:
e Address Update Records
e Income Update Records
e Health Benefits Update Records
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Create Progress Logs

From the Client Profile, you may enter notes into Progress Logs to document correspondence or

communication with the client. Click the Create > Progress Log to open the Progress Log form.

Client Profile : Marie Castle ()
Virginia Department of Health - Care £

Address  Profiles  Care

Status

Date of Last Service
Legal Last Mame
Legal First Mame
Legal Middle Initial
Mame Suffix

Prefemed Mame
Pop-up Alet Message

CChl

Adm

inistrative Mote

Appointment
Eligibility Assessment
Letter

Progl

ress Log

Referral
Required Action

Scan

Servi

ce Provided

TB Assessment

Test Result

Web

User Account

4 Close ;?'|: = E|v|ﬁEd'rt @ Create = (& View ~ (@ Action = & Print -

L [06/30/2021]

Enrollments

Medical

H

Enter the required fields into the Progress Log Form.

i Close “ZF H o Complete () Get Sample Tet  [= Link to Client Profile

Progress Log : Marie Castle ()

Virginia Department of Health - Care Services : Peggy Griffith/GTI/ADMIN [07/08/2021]

Summary  Appointmerts  labs  Referals  Services

Status

Provider

Date

Minutes

Contact Categony
Contact Type
Funding Source

Brief Description

Full Description

In Progress

Peggy Griffith

[}

07/08/2021

On the Summary tab in the Health Benefits update, fill in the appropriate fields:

e Status — defaults to “In Progress” until the Progress Log is completed
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® Provider — defaults to User Name

e Date — defaults to the current date

® Minutes — enter the number of minutes spent with the client

e Contact Category — select from the list, the appropriate category and contact type

e Contact Type — defaults based on Contact Category selected

e Funding Source — defaults based on Contact Category selected

e Brief Description — enter a short description of the subject matter (consider this the subject line)
o Full Description — enter the detailed notes regarding the encounter with the client

When you are finished with the Progress Log, click % Complete
Viewing Activity

To view activity that has taken place on the client’s record, click View > Activity from the Client Profile.

qCose %|e= = [~ #Edt @©Ceate v © View v © Acton = @ Frint ~

Client Profile - Marie Castle () R
Virginia Department of Health - Care Services - Peg ADAP Medication Transactions

Profle  Demo Address  Profiles Care Team  Finances Address History

The following list appears, categorized by the type of activity entered in Provide. Double-click on any
activity to see details.

| 4 Close
BSEBBEWFdED
Form Deleted Summary *
=l Appointment
Appointment 2021/07/08: Scheduled - Ambulatory Outpatient Medical Care at (Forest)Bon Secours |D Specialists with Acuna, Dr
= Eligibility Assessment
Eligibility Assessment 2021/07/02 - Submitted
Eligibility Assessment 2021/06/30 - Processed
=1 Eligibility Assessment Web
Eligibility Assessment Web 2021/07/02 - Accepted
Eligibility Assessment Web 2021/06/30 - Accepted
I=| Progress Log
Progress Log 2021/07/08: Complete - ADAP Medication Assistance - Telephone Call {Virginia Department of Health) - Support call 7/8/2021
Progress Log 2021/07/08: Complete - ADAP Medication Assistance - Telephone Call (Virginia Department of Health) - Support Call 7./8/2021
¥l Scan
% Scan Web
14l Test Result
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